








  Gérer un corpus d’images avec Tropy

  UPPA - ED 481 SSH / Outils pour les humanités numériques

  Julien Rabaud

  2024-09-24




1 Accueil
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Tropy - Vue items en gallerie
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Tropy - Vue items en liste
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Tropy - Photo et sélections









Tropy est un logiciel libre (open source) conçu pour organiser et gérer des collections d’images. Développé par la fondation Digital Scholar (qui développe aussi Zotero et Omeka), il est principalement utilisé dans le domaine de la recherche en sciences humaines et sociales (même s’il est aussi apprécié par les usager·ère·s plus grand public des services d’archives comme les généalogistes. (voir Valmalle, 2021)).

Il permet aux chercheur·es de classer, anoter, et organiser des photos et des documents numérisés, comme des archives ou des manuscrits, en vue de faciliter leur utilisation et leur éventuelle publication.

Principales fonctionalités :


	Création de projets pour organiser les images par collections et catégories (tags).

	Ajout de métadonnées détaillées à chaque objet (item), image et zone d’image (sélection).

	Possibilité d’associer des annotations aux images et aux sélections.

	Exportation des données sous forme de fichiers compatibles avec le web sémantique (format JSON-LD par défaut) ou avec d’autres logiciels (comme Zotero ou OmekaS avec les extensions dédiées).










2 Des métadonnées riches…


Dans la documentation de Tropy : What is metadata and how do I use it?




2.1 Que sont les métadonnées ?

Les métadonnées sont des données qui décrivent d’autres données. Elles fournissent des informations sur un fichier, un document, ou tout autre type de ressource numérique. Par exemple, pour une photo, les métadonnées peuvent inclure le titre, le nom du créateur, la date de création, le format, et les droits d’utilisation.

Les métadonnées aident à organiser, identifier et trouver facilement des informations en donnant des détails sur le contenu, la structure et le contexte des données (ici vos objets, images et sélections).


2.1.1 Qu’est-ce qu’un schémas de métadonnées ?

Un schéma de métadonnées est un ensemble structuré de règles et de propriétés utilisées pour décrire de manière cohérente des données ou des ressources. Il définit quelles informations (ou métadonnées) doivent être collectées, comme le titre, le créateur, la date, ou le type de ressource, ainsi que la manière de les organiser.

Un schéma de métadonnées est une structure standardisée qui aide à organiser et harmoniser les informations descriptives sur des fichiers ou documents, facilitant ainsi leur recherche et leur gestion.

Dans Tropy, des schémas de métadonnées comme les Dublin Core, Exif, ou Europeana Data Model (EDM) sont chargés par défaut. En fonction des besoins de votre projet et du type d’objets que vous décrivez, vous avez également la possibilité de personnaliser ou importer vos propres schémas selon des standards adaptés à vos recherches (comme CIDOC-CRM, VRA Core…).




2.2 Les schémas Dublin Core

[image: ]

Il existe deux schémas de métadonnées dits Dublin Core, tous deux disponibles par défaut dans Tropy : le Dublin Core Metadata Element Set et les Dublin Core Metadata Terms.

La différence entre les Dublin Core Elements et les Dublin Core Terms réside principalement dans leur étendue, leur structure, et leur niveau de formalisation.
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3 Pour réutiliser ou partager son corpus

Si vous citez vos photos dans un document de recherche, vous pouvez avoir envie de les déposer dans un entrepôt de données (pour les partager, les réutiliser plus tard ou les archiver). Il convient alors d’adapter son modèle de saisie dans Tropy aux propriétés demandées ou disponibles dans l’entrepôt visé.


3.1 Exemple de Nakala

Nakala est l’entrepôt de données de HumaNum. Vos photos de recherche peuvent être considérées comme des données de recherche (surtout si vous les utilisez dans vos publications).

Huma-Num, dans la riche documentation de Nakala, a publié un Guide pour décrire ses données dans Nakala (Huma-Num, 2024).

Huma-Num a aussi publié une fiche pdf imprimable d’aide au dépôt dans Nakala (mars 2024).
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4 Créer un projet
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Menu: Fichier > Nouveau > Projet (Ctrl+Maj+P)




	Lui donner un nom


	Choisir le type (voir Lucchesi et al., 2023).


	Standard : Copie les photos dans le dossier du projet à l’import

	Advanced : Lien vers les photos sur votre disque (/!\)




	Choisir l’emplacement du projet sur son ordinateur








Suggestion




Dans le dossier Images par défaut, un sous-dossier Tropy, puis un sous-dossier par projet.














  
  
  ch005.xhtml
  
  

  
  



5 Les modèles de saisie
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Préférences de Tropy > Modèles de saisie




5.1 Trois types d’objets dans Tropy

Donc trois types de modèles :


	Objet (Item) contient une ou plusieurs Photos

	Photo Contient zero, une ou plusieurs Sélections

	Sélection





5.2 Dans la documentation officielle


	Getting started with templates





5.3 Les modèles inclus dans Tropy


	Niveau item : Tropy Generic, Tropy Correspondance et Dublin Core

	Niveau photo : Tropy Photo

	Niveau selection : Tropy Selection



Ces modèles ne peuvent être supprimés ni effacés.



5.4 Créer ou personnaliser un modèle de saisie


5.4.1 Créer un modèle

Dans la fenêtre des préférence, onglets des modèles de saisie :




	Vider le champ Modèle de saisie

	Entrer un Nom (au choix)

	Choisir le Type (Objet, Photo ou Sélection)

	Renseigner le Créateur (Vous)

	Ajouter une petite Description

	Cliquer sur Créer







[image: ]

Nouveau modèle








5.4.1.1 Ajouter des propriétés
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Propriété






5.4.2 Personnaliser un modèle


	Cliquer sur l’icône Dupliquer



[image: ]

Dupliquer




	Ajouter, supprimer, déplacer, modifier les propriétés







5.5 Exemple du Projet Blot


	Template BlotPhotosV2.ttp : Télécharger

	Description dans le wiki du projet
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6 Les extensions (Plugins)
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Menu: Préférences… - Plugins




Table des extensions






	Nom (et lien)
	Description





	tropy-plugin-csl
	Tropy plugin to export your items to Zotero as CSL/JSON



	tropy-plugin-omeka
	This plugin can export selected items into an Omeka S instance.



	tropy-plugin-archive
	Tropy plugin for exporting items into a single zip archive. This includes all the metadata, as well as the photo files.



	tropy-plugin-csv
	Tropy plugin to import items from a CSV file, and export your items to CSV.



	tropy-plugin-iiif
	Download a IIIF manifest and select File > Import > tropy-plugin-iiif to start the import. The plugin tries to map the manifest’s metadata to standard metadata properties.
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7 Importer des photos


7.1 Formats supportés


	JPG/JPEG

	PNG

	SVG

	TIFF

	GIF

	PDF

	JP2000

	WEBP

	HEIC

	AVIF










Attention





	Projet Standard

	Copie des fichiers dans le dossier du Projet

	Risque de doublon sur le disque dur (place)






	Projet Advanced

	Simple création d’une miniature et lien vers l’emplacement du fichier sur votre disque

	Risque de perte de données dans le projet si vous déplacez ou supprimez vos fichiers














7.2 Par le Menu Fichier

... > Fichier > Importer > Photos | Dossier


	Penser à définir le bon modèle d’import par défaut avant.



[image: ]

Préférences de Tropy > Paramètres








7.3 Par glisser-déposer


	De la fenêtre du dossier d’origine vers la fenêtre de Tropy (vue projet)


	Même recommandation (modèle d’import).






7.4 Par surveillance d’un dossier


	Menu édition:

... > Édition > Préférences...

Onglet Projet -> Watch folder…






7.5 Par des plugins/extensions


7.5.1 CSV


	Installer le plugin CSV

	Menu: Edition > Préférences… | onglet Plugins -> Définir un profil d’import CSV

	Menu: Fichier > Importer > Profil CSV : chemin du fichier .csv





7.5.2 IIIF


	Installer le plugin IIIF

	Menu: Edition > Préférences… | onglet Plugins -> Définir un profil d’import (modèle de saisie) IIIF dans les paramètres du plugin.

	Télécharger un manifeste IIIF (souvent un fichier manifest.json) sur son ordinateur depuis un catalogue IIIF (Gallica, Biblissima, Europeana..)

	Liste de collections utilisant IIIF pour partager leurs ressources (IIIF Consortium, 2024)




	Dans Tropy, Menu: Fichier > Importer > Profil IIIF : chemin du fichier manifest.json
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8 Exporter (projet, photos, données)


8.1 Préférences > Export



8.2 Menu Exporter


	JSON-LD : LD pour Linked Data

	PDF

	Plugins





8.3 Plugins


	Archive : Photos et métadonnées dans un .zip

	CSV

	Omeka S

	CSL (Zotero)





8.4 Imprimer
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9 Canaux officiels


	Documentation

	Support (forum)

	Vimeo

	Youtube

	X/Twitter

	GitHub (code source, templates…)
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10 Tutoriels


Table des Tutoriels Tropy






	Auteur
	lien





	Benjamin Lailler
	Tutoriel Tropy (Laillier, 2019)



	Stretching numérique 2024
	Gérer ses photos d’archives avec Tropy (Leromain, 2024)



	Schlesinger Library on the History of Women in America - Harvard University
	Manage Research Images With Tropy (Fauxsmith, 2019)



	BULAC
	Gérer ses ressources iconographiques avec Tropy (Maisonneuve, 2024)



	Rennes 2
	Gérer ses photos de recherche avec Tropy (Croizet, 2024)
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11 Vidéos




	Le 16 juin 2020, L’équipe de Tropy (Abby Mullen) a tenu un webinaire de type Tropy 101 [Youtube - 1h05]

https://www.youtube.com/embed/jWjP90EWHkQ


	Tropy chanel : Metadata Templates in Tropy [Youtube - 10 mn]

https://www.youtube.com/embed/Hk5APGD6200










	Projet EVEille : Séance d’initiation à Tropy, animée par Benoît Roux, juin 2021 [e-diffusion UHA - 1h28]

https://e-diffusion.uha.fr/video/4023-initiation-a-tropy-avril-2021


	(Valmalle, 2021) Geneatech : Utiliser Tropy pour la gestion de ses photos d’archive [Youtube - 17 mn]

https://www.youtube.com/embed/AiPqbdwP67E
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12 Billets de blog


	Gérer ses photos d’archives avec Tropy - Franziska Heimburger - La boîte à outils des historien·ne·s (Heimburger, 2017)

	Tropy, un gestionnaire de photos d’archives pour les chercheurs - Florian Innocente, MacGeneration (Innocente, 2017)

	Six months of using Tropy - Emmanuel Mourlon-Druol (Mourlon-Druol, 2019)

	Tropy : un logiciel pour organiser des corpus iconographiques - Le Carreau de la BULAC (Larguèche, 2021)

	Personal image management software rec from an art historian: Tropy - Elizabeth Lee - The Digital Orientalist (Lee, 2021-03-16T)

	New Project Types in Tropy 1.13 - Tropy Blog (Lucchesi et al., 2023)
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Appendix A — Produire des données FAIR


	Inspirés par le 5-Star Open Data proné par Tim-Berners Lee, mis en forme par Michael Hausenblas sur ce site : http://5stardata.info/fr/ [22 janvier 2012].










Les étapes 5-Star OpenData





Illustration des étapes 5-Star OpenData






	étoiles
	étape





	★
	Publiez vos données sur le Web (peu importe leur format) avec une licence ouverte



	★★
	Publiez-les en tant que données structurées (par exemple, un document Excel au lieu d’une image scannée d’un tableau)



	★★★
	Publiez-les dans un format ouvert et non-propriétaire (par exemple, un CSV plutôt qu’un Excel)



	★★★★
	Utilisez des URI pour désigner des choses dans vos données, afin que les gens puissent faire des références à celles-ci



	★★★★★
	liez vos données à d’autres données pour y ajouter du contexte












	Décrits ici, d’aprèsThe FAIR Guiding Principles for Scientific Data Management and Stewardship. DOI




The principles refer to three types of entities: data (or any digital object), metadata (information about that digital object), and infrastructure. For instance, principle F4 defines that both metadata and data are registered or indexed in a searchable resource (the infrastructure component).
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Appendix B — Autour des standards IIIF




IIIF (International Image Interoperability Framework™) est un ensemble de standards qui définissent un cadre d’interopérabilité pour la diffusion des images numériques sur le Web.







IIIF permet la manipulation homogène d’images indépendamment de leurs localisations physiques et des établissements qui les hébergent. (utilisé notamment sur Europeana1 , Gallica2, Nakala, de nombreux serveurs Omeka…)


	Une excellente documentation chez Biblissima.


	Une très large collection de ressources sur le GitHub du consortium : Awesome International Image Interoperability Framework (IIIF)


	La visionneuse Mirador





B.1 Importer dans Tropy des documents Gallica via le module IIIF


	API IIIF de récupération des images de Gallica :


	Base URL : gallica.bnf.fr/


	Manifest : iiif/{ark}/manifest.json


	Modèle : gallica.bnf.fr/iiif/ark:/XXXXX/manifest.json


	Exemples :


	gallica.bnf.fr/iiif/ark:/12148/bd6t538312611/manifest.json

	gallica.bnf.fr/iiif/ark:/12148/btv1b8451475v/manifest.json











B.2 Bonus


	Publier une image avec ses annotations : utilisation de Tesselle en histoire de l’art - Antoine Courtin (Numérique et recherche en histoire de l’art, 2020).

	Tesselle - médialab SciencesPo




	Avec des sources iiif : Adno

	Exemples

	Documentation












1. Europeana IIIF APIs



2. API IIIF de récupération des images de Gallica
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Guide de dépot

Ce guide est mis a disposition des personnes qui déposent ou accompagnent au dépdt des données
dans I'entrepét NAKALA.

NAKALA est un entrepdt de données de recherche pour les sciences humaines et sociales. Son acces
et son utilisation sont décrits dans la documentation d’Huma-Num:
https:/documentation.huma-num.fr/nakala/

La qualité et la richesse de la description des données sont des criteres centraux des principes FAIR.
Cela constitue un moyen d’atteindre les objectifs visés (faire en sorte que les données soient faciles a
trouver, accessibles, interopérables et réutilisables).

La qualité se met en ceuvre, par exemple:

o enutilisant des référentiels standardisés;

o enrespectant les mémes normes intellectuelles de description pour un ensemble de données;
e enchoisissant des champs de métadonnées les plus adaptés a I'information donnée.

La richesse se met en ceuvre en complétant le plus grand nombre possible de champs afin d’optimiser
la compréhension des données. Dans NAKALA, la description est basée sur un ensemble minimal de
cing informations qui peuvent étre enrichies de maniere étendue et cumulative.

Ce guide propose un ensemble de conseils et bonnes pratiques pour les fichiers et les champs de
métadonnées obligatoires et complémentaires de premier niveau.

Pour aller plus loin, un guide de description est disponible :
https:/documentation.huma-num.fr/nakala-guide-de-description/

Contact: nakala@huma-num.fr

Les fichiers

R Commentaires et propositions
ClfizrEs d’amélioration

Il est recommandé d’établir un plan de nommage (préfixe commun pour tous les fichiers

associés au projet) afin que les noms des fichiers soient cohérents et réguliers.

Remarque : pour un dép6t multifichiers, NAKALA permet de trier les fichiers par ordre alphabétique,

apres chargement.

Nommage

La description des fichiers peut étre saisie:
« pour des informations spécifiques a un fichier, dans le champ «Description» associé a chaque
fichier.
Description Ces informations sont indexées par NAKALA et sont affichées dans la visionneuse.
« pour des informations globales sur I'organisation interne, le contenu, la définition des variables
du ou des fichiers de la donnée, dans un document a part (type README, manifest IlIF, TEI-
header, métadonnées métier, METS, etc.).

NAKALA accepte tous les formats, mais quand c’est possible, privilégier un format ouvert
compatible avec FACILE, le service de validation des formats: https://facile.cines.fr/

Pour les fichiers au format texte, I'encodage de caractéeres en UTF-8 est recommandé, si
Formats applicable.

La liste des formats supportés par I’API IMAGE llIF dans NAKALA: «tif», «tiff», «jpg», «jpeg»,
«jp2», «png», «pdf», «geojp2».
Ces formats sont recommandés pour bénéficier des fonctionnalités du protocole IlIF.
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Les métadonnées
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2 Cas d’un auteur dit
(¢} «anonyme»
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()

‘O Date de création

Licence

Description

Résumé

Table des matieres

Mots-clés

Ajout de mots-clés dans
une langue secondaire

Informations complémentaires Métadonn

Langues

Métadonnées
géospatiales
dcterms:spatial

Métadonnées
temporelles
dcterms:temporal

Lien vers la publication
dcterms:
bibliographicCitation
et/ou
dcterms:isReferencedBy

Ajouter d’autres métadonnées

Droits
dcterms:rights

Editeur
dcterms:publisher

Relation vers des
ressources externes:
données hors NAKALA,
base de données, etc.
dcterms:relation

Remarques

Commentaires
Criteres et propositions
d’amélioration

Vérifier que le type sélectionné est adapté a la donnée.
Remarque : dans le cas d’'une donnée multifichiers, le type sélectionné rend compte du type principal de la donnée.

Renseigner un titre explicite et signifiant (comme le serait un titre d’article).
Remarque : si un titre non signifiant est nécessaire (identifiant ou nom de fichier), il peut étre ajouté dans un second
champ «Titre».

Veérifier que le nom des auteurs respecte la forme : Prénom Nom.
Pour toutes autres formes d’auteurs, cocher « Anonyme» et les renseigner dans dcterms:creator
ou dcterms:contributor (zone « Ajouter d’autres métadonnées»).

Si lauteur dispose d’un identifiant ORCID, renseigner cet identifiant.
Remarque : si 'auteur est déja enregistré et que son ORCID n’est pas renseigné, demander la mise a jour en écrivant a
nakala@huma-num.fr.

Vérifier s’il est possible de renseigner au moins une personne ayant participé a la production, a la collecte ou au
traitement des données dans dcterms:creator ou determs:contributor (zone « Ajouter d’autres métadonnées »).
Remarque : les noms renseignés dans dcterms:creator s’affichent dans le bloc de citation.

Renseigner la date de création de la source originale ou de la ressource numérique. Seuls les formats de date
suivants sont possibles : YYYY-MM-AA (année-mois-jour), YYYY-MM (année-mois), YYYY (année).

Pour toutes autres formes de dates, cocher «Inconnue» et les renseigner dans dcterms:created

ou dcterms:date (zone « Ajouter d’autres métadonnées»).

La licence associée a la donnée est de préférence libre (Creative Commons, Etalab, GNU, etc.) et correspond
aux droits de réutilisation possibles.
Remarque: vérifier ce qui justifie le recours a une licence non libre.

Décrire la donnée du point de vue scientifique : contexte de production et/ou de collecte ; méthodologie ;
objectifs, etc.

Décrire le programme de recherche dans un autre champ «Description».
Saisir le résumé du projet dans dcterms:abstract (zone «Ajouter d’autres métadonnées»).

Saisir une liste ou une table des matieres dans dcterms:tableOfContents (zone «Ajouter d’autres
métadonnéesy»).

Renseigner au moins 2 a 3 mots-clés précisant le contenu intellectuel et le sujet de la donnée en frangais est
fortement recommandé.

Le mot-clé doit étre sous forme d’un mot, d’un groupe de mots ou d’une URI qui renvoie vers un référentiel de
mots-clés.

Si des mots-clés sont renseignés dans une autre langue, les renseigner dans un autre champ «Mots-clés ».

Pour des fichiers vidéo, son et texte, renseigner la ou les langue-s du contenu des fichiers.

Renseigner la couverture géographique du contenu intellectuel des données dans dcterms:spatial si pertinent.

Renseigner le positionnement hiérarchique de la localité est recommandé : «France, Auvergne-Rhéne-Alpes,

Rioupéroux».

Dupliquer le dcterms:spatial pour renseigner certains types d’'informations spatiales normalisées :

« pour un concept issu du Thesaurus of Geographic Names (Getty Thesaurus of Geographic Names - TGN) :
saisir I'identifiant du concept issu du TGN et sélectionner dans « Type» : dcterms: TGN.

« pour une zone géographique : saisir les informations de la zone géographique et sélectionner dans « Type»:
dcterms:Box.
Ex. Pour la zone géographique qui correspond a I'’Australie occidentale, I'information doit respecter la forme
suivante : name=Western Australia; northlimit=-13.5; southlimit=-35.5;westlimit=112.5; eastlimit=129.

« pour des coordonnées géographiques : saisir les coordonnées géographiques et sélectionner dans «Type» :
dcterms:Point.
Les coordonnées géographiques doivent étre saisies dans la forme suivante : name=Perth, W.A.; east=115.
85717; north=-31.95301.

« pour un code pays issu de la norme ISO3166 : saisir le code pays issu de ISO3166 (code Alpha-2) et sélectionner
dans «Type» : dcterms:ISO3166.

Pour des précisions sur les formes a respecter lors de I'utilisation des « Types», se référer au guide de description :

https://documentation.huma-num.fr/nakala-guide-de-description

Renseigner la couverture temporelle du contenu intellectuel des données dans dcterms:temporal.
Sil'information est sous la forme d’une période (temporelle ou historique) avec un intervalle temporel délimite,
sélectionner dans « Type» : determs:Period.

Linformation doit respecter la forme suivante : «name=Haut empire Romain; start=-0030; end=0099 » ; saisir
quatre chiffres est obligatoire pour renseigner les années ; 'année «start» doit étre antérieure a 'année «end».
Pour des précisions sur les formes a respecter lors de I'utilisation des « Types», se référer au guide de description :
https:/documentation.huma-num.fr/nakala-guide-de-description

Siune publication est associée aux données, il est fortement recommandé de 'indiquer .

Renseigner la référence bibliographique complete dans dcterms:bibliographicCitation (vérifier que I'identifiant
pérenne de la publication est renseigné ou I'ajouter, si applicable).

Saisir I'identifiant pérenne de la publication dans dcterms:isReferencedBy, si applicable.
Aucune information de langue ne doit étre saisie.

Siun embargo sur un ou des fichiers a été apposé, il est recommandé d’en préciser la raison dans un
dcterms:rights.

Saisir le nom du responsable de la mise a disposition de la ressource dans dcterms:publisher (le nom du
laboratoire dans sa forme actuelle, par exemple).

Si des données déposées dans d’autres entrepdts (projet interdiscplinaire) ou dans des ressources sur le web
(base de données, sites, bibliotheques numériques, etc.) sont en lien avec la donnée, il est recommandé de les
indiquer dans dcterms:relation.

Saisir I'identifiant pérenne de la ressource externe a mettre en relation.
Lorsqu’une URI est renseignée, sélectionner dans le champ « Type» decterms:URI.
Aucune information de langue ne doit étre saisie.

Il est fortement recommandé de préciser la langue de chaque métadonnée renseignée sous forme textuelle.
Si vous avez uniquement renseigné une URI dans une métadonnée, sélectionner dans le champ « Type» dcterms:URI et ne surtout pas renseigner d’information de

langue.
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